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System settings and requirements 

 

Minimum system requirements 
 
 

Hardware 
  

Software 
  

    
 

Platform 
CPU RAM 

Hard 
OS 

 Internet 
 

 
drive 

 
Browser  

     
 

Windows
®
 Intel Core 2 Duo 2.33GHz 1 GB 80 GB XP SP3 (32bit)  IE 6 

 

Macintosh
®
 Intel Core i7 2GHz 4 GB 500 GB Snow Leopard  Safari 

 

 

Note: Vector NTI® Express is only supported on single processor machines. The software is not 

designed to run on multi-processor machines; such configurations cannot be guaranteed to 
operate successfully. 

 

Windows
®

 operating systems only: Local administrator account 
 

On the Windows
®

 operating system, you must be logged in as a local administrator to install the 

software. 
 

Dynamic licensing 
 

This document does not address Dynamic Licensing of Vector NTI® Express or DLS installation. Customers 

with a DLS License should first install and license the DLS software before installing Vector NTI® Express. 
 

For information on DLS installation and dynamic licensing of Vector NTI
®

 Express, see the DLS 

Installation and Licensing Guide, available by following the link to Vector NTI
®

 Express on  
http://lifetechnologies.com/vectornti. 

 

Download the software 
 

1. To download the software, go to  http://lifetechnologies.com/vectornti and follow the links to the 

Vector NTI® Express download page.  

2. Follow the instructions on the page to download the software.  
 

3. When the download is complete, depending on your browser settings, you will be prompted to save or run 

the installer.  

 

Install the software 
 

1. If you are not prompted to automatically run the installer after download, navigate to the download 

location and double-click on the installer (e.g., VectorNTIExpressInstall.exe) to begin installation.  
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2. While installing Vector NTI® Express software on the Windows 8 operating system, if the Windows 

Smartscreen is enabled or if Windows 8 prompts the screen shown in the screenshot, click More info as 

shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Clicked Run anyway to proceed with the installation. 
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4. Click Yes to allow the Vector NTI® Express software to be installed onto your computer. 

 

 

 

 

 

 

 

 

 

 

 

 
 

5. The installation files will be extracted. If a previous version of Vector NTI
®

 Express is installed, you 

will be prompted to uninstall it before proceeding.  
 
 
 
 
 
 
 
 
 

Note: During uninstall, you will be prompted to save your old database. After uninstall is complete, double-click 

on the installer again to begin the installation. 
 

6. If prompted with a security warning, press Run to proceed.  
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7. In the next screen, click Next.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. In the next screen, accept the license agreement and click Next.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

9. In the next screen, click Next to accept the default install directory, or Browse to select a different one.  

Note: Life Technologies recommends installing Vector NTI
®

 Express on a computer hard drive, not a 

network drive.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vector NTI
®

 Express Installation and Licensing Guide 7 

 



10. In the next screen, click Install.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
11. During installation, a local Vector NTI

®
 Express database is created. This database initially contains a set 

of standard vectors and other molecules from Life Technologies.  

 
12. When installation is complete, select the Run Data Migration Tool checkbox to import your data 

from the Vector NTI
®

 Advance database into Vector NTI
®

 Express.  
 

Note: The Data Migration Tool may take several minutes to import your data. You can also import your data 

later from within Vector NTI
®

 Express by selecting File > Import.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Launch the software 
 
Windows

®
 operating systems: A desktop icon and Start menu folder will be created during installation. Double-

click on the icon or select the application from the Start menu to launch the software. 
 
Mac

®
 OS: To launch the software, go to /Applications/VectorNTIExpress.app. 

 

License the software 
 
New installations of Vector NTI® Express will open in Demo Mode, which allows you to perform limited 
operations with the software. You cannot save changes or analysis results in Demo Mode. 
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Order a license 
 

You can order a license for Vector NTI® Express on our website at  www.lifetechnologies.com/vectornti. Follow 

the links to the Vector NTI
®

 Express Pricing page.  
For a free trail license, click on the link on the Vector NTI

®
 Express page, or email your contact 

information to  bioinfotrial@lifetech.com. 
 

Types of licenses 
 
To satisfy the needs of users in different industrial, scientific or educational environments, Life 

Technologies has designed the following Vector NTI® Express licenses: 
 
• Trial License: Allotted to a potential purchaser of Vector NTI® Express for a specified number of days, during 

which the user can review and use the software within certain limits.  
 
• Static License: Purchased by one user for installation on one computer.  
 
• Corporate Static License: Static license that is used throughout a corporate organization.  
 
• Term License: Static Licenses are also available as 1-year and 3-year fixed-term licenses.  
 

• Dynamic License (DLS): A license that is installed on a server and issued by that server to client computers 

running Vector NTI® Express software. DLS licenses are shared by a specified number of  users or “seats,” 

with the number of users at any one time being limited to the number of “licenses” specified in the contract. 
 

Enter the license number 
 
Note: To license Vector NTI® Express, you need a new License Number. If you have no connection to the 

internet, you also need a new Registration Key. The Registration Key is provided by Life Technologies 
based on your License number and Hardware ID. 

 
After you receive a license from Life Technologies, you can enter it into Vector NTI® Express using the 
License Manager: 
 
1. Go to Help > License Manager.  
 
 
 
 
 
 
 

 

2. In License Manager, click on the User Information tab and enter your information.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Vector NTI

®
 Express Installation and Licensing Guide 9 

http://www.lifetechnologies.com/vectornti
mailto:bioinfotrial@lifetech.com


 
3. Click on the Applications tab. Your current license is displayed along with the contract number.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4. In the Applications tab, click on the button for the type of license you have and enter the license 

information as described in the following sections.  
 

Note: After you enter the new license, you will need to close and restart Vector NTI
®

 Express to apply 

the new license to it.  

 
Static License 
 
To enter a Static License: 
 
1. In the Applications tab, click the Static button.  
 
2. Enter your information in the appropriate fields.  
 

3. In the License # field, enter the Vector NTI® Express static license number provided in the email you 
received from Life Technologies. The hardware ID is pre-loaded in its text box.  

 
4. Personal Static License: You must have an internet connection for this type of static license. Click the Apply 

button. The license is submitted via the internet and a registration key is returned and applied automatically.  

 

Corporate Static License: You must have an internet connection for this type of static license. Click the 

Apply button. The license is submitted via the internet and a registration key is returned and applied 

automatically.  
 

If registration of your personal static license fails because of a problem with the internet 

connection, contact Life Technologies Technical Support and provide them with your 

computer’s hardware ID and your license number. Once you receive the registration key, 

enter the key in the Key text box of the Static License dialog box and click Apply. If the Key 

matches your license number and computer hardware ID, the license is registered. 
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Trial License 
 
To enter a Trial License: 
 
1. In the Applications tab, click the Trial button.  
 
2. Enter the trial license you received in the field, then click on Apply.  

 

Dynamic License from a DLS Server 
 
To configure a Dynamic License for Vector NTI® Express, see the Installation and Licensing Guide for 
Vector DLS 3.0 available at  www.lifetechnologies/vectornti. 
 
To enter a Dynamic License: 
 
1. In the Applications tab, click the Dynamic button.  
 
2. Enter your information in the appropriate fields.  
 
3. Select the DLS server requires authentication checkbox, and enter your name and password for the server.  

 

4. If you have trouble connecting to the server, click on the Internet Connection Settings button to try new 

connection settings, then click on Test Connection to test the settings.  

 

Software Updates 
 

Vector NTI® Express has a software update server that can be checked automatically or manually:  
1. Go to Tools > Preferences.  
 

2. In the Preferences dialog, the update site URL is specified as follows:  
• For Windows

®
 OS:  

http://downloads.lifetechnologies.com/Analysis_Software/MCB/VNTI/UpdateSitePlugin/Updates.  

win32/1.0  
 
• For Macintosh

®
 OS:  

http://downloads.lifetechnologies.com/Analysis_Software/MCB/VNTI/UpdateSitePlugin/Updates.  

mac/1.0  
 
3. To automatically check for updates each time the software is launched, select the Automatically find new 

updates and notify me checkbox. To manually check for updates, go to Help > Check for Update after you 

have launched the software. 
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Windows
®

 operating systems: Multiple users on the 

same computer 
 
You can run Vector NTI

®
 Express from different user accounts on the same computer. (See your Windows

®
 

operating system documentation for information about setting up multiple user accounts.)  
Note the following: 
 

• With this type of installation, a single local database is shared among users on the same 

computer.  
 

• An Administrator account is required to install the software, but more restricted accounts (e.g., 

Restricted User, Standard User) can run the software.  
 

1. From an Administrator account, install Vector NTI
®

 Express on the computer.  
 

Make sure that the local database is installed in an unrestricted root directory (e.g., the 

default C:\vectorntiexpress_database directory) that can be accessed by all users. 
 
 
2. After installation, launch the software in the Administrator account, open License Manager (Help > License 

Manager), and enter the license as described in the licensing section of this installation guide (see page  7).  

 

3. Log on to each user account and run the software as usual.  

 

Transfer software to a new computer or operating 

system 
 
The license number and Hardware ID of your computer are closely linked. Changes to the computer operating 

system can result in a change to the Hardware ID, which will revoke the existing license. 
 
If the operating system changes or the software is to be moved to a different computer, you must unregister 

the license before the software is uninstalled from the current computer. To do so, type “unregister” in 

License# field, and press the Apply button. An internet connection is required. 
 
On the destination computer, install the software, and apply the existing license. 
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Appendix A. Technical support 
 

Technical resources on the web 
 
Technical resources for Vector NTI

®
 Express Software are available online at: 

 http://lifetechnologies/vectornti. 
 

Annual support contract 
 
For personalized technical support by telephone or email, you must have a paid annual software 

maintenance and support contract. To purchase an annual support contract, email  

bioinfosales@lifetech.com or contact Life Technologies customer support at  

www.lifetechnologies.com/support. 
 
If you have a paid annual support contract, you can contact us by email or phone: 
 

• Email:  bioinfosupport@lifetech.com  
 

• Phone:  
 

- 800 955 6288 (North America)  
 

- +44 (0) 141 814 6318 (Europe, Middle East, Africa)  

 

Other Life Technologies technical support 
 
For additional Life Technologies technical support, visit  www.lifetechnologies.com/support. 
 

Product warranty 
 
Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the Life 

Technologies’ General Terms and Conditions of Sale found on Life Technologies’ website at  

www.lifetechnologies.com/termsandconditions. If you have any questions, please contact Life 

Technologies at  www.lifetechnologies.com/support. 
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Appendix B. Reinstallation policy 
 

 
Effective January 1, 2012, depending on the status of the Advanced Support Contract you may or may not have with 

us, the service coverage is different: 
 
1. If you do have a current, paid Advanced Support Contract with Life Technologies, then you are entitled to an 

unlimited number of license support incidents for your Vector NTI
®

 Express software license. However, if you 

do not have a current, paid Advanced Support Contract with Life Technologies, then you are only entitled to 

one courtesy (no charge) license support incident for your Vector NTI
®

 Express software license.  

 

2. For Vector NTI
®

 Express version 1.0, if you do not have a current, paid Advanced Support Contract, Life 

Technologies grants a one-time only license support incident for the number of computers registered per your 

original purchase order. For example, if you purchased license(s) for 10 computers, you will be entitled to a 

one-time courtesy (no charge) reinstallation for up to 10 computers. After that, no more courtesy (no charge) 

reinstallations will be granted.  
 
3. As we introduce new major version releases, only the most current and one prior version will be eligible for 

license support, regardless of the type of licensing (i.e., Static, Dynamic, Network). This is a standard industry 

practice.  
 
To request Reinstallation Service, please visit our website and submit out a Reinstallation Request Form, 

available on the web at: 
 
 https://www.invitrogen.com/site/us/en/home/Products-and-Services/Applications/Cloning/vector-nti- 

software/vector-nti-advance-software/Support/Re-Install-Request-Form.html 
 
A valid license number and hardware ID is required. 
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Appendix C. Vector NTI
®

 Express Software and Support 

Product License Agreement 

 

VECTOR NTI® EXPRESS SOFTWARE  
END USER LICENSE AGREEMENT  

This is a legal agreement between you, the person or entity receiving software products and/or software support (“Licensee”), 

and Life Technologies Corporation, having offices at 5791 Van Allen Way, Carlsbad California 92008 USA (“Licensor”). This 

agreement is part of a package that includes one or more software products and certain electronic and/or written materials. 

This agreement covers your licensing of such software and/or purchase of support.  
You must agree to the terms in this End User License Agreement (“EULA”) in order to access the software and/or receive 

support. 
 
 
 
BY CLICKING YOUR ACCEPTANCE OF THIS EULA, OR BY INSTALLING OR USING THE SOFTWARE (defined below) OR ANY 

OTHER COMPONENT OF THE PACKAGE, YOU ACKNOWLEDGE THAT YOU HAVE READ ALL OF THE TERMS AND 

CONDITIONS OF THIS EULA, UNDERSTAND THEM, AND AGREE TO BE LEGALLY BOUND BY THEM. If you do not agree to 

the terms of this EULA, you may not install or use the Software, and may return it to Licensor for a refund or product credit. In 

addition to the restrictions imposed under this EULA, any other usage restrictions contained in the Order (defined below), 

Software installation instructions or release notes, and Support policies (defined below) shall apply to your use of the 

Software and receipt of Support.  
As used in this EULA: “Authorized Users” means, collectively, the personnel authorized by you to use the Software for your benefit, 
provided you have both purchased a License (as defined below) and paid the corresponding license fees. Unless otherwise expressly 
allowed by this EULA, Authorized Users may include only your employees and agents having a need to know, and Authorized Users  
may not be entities or persons in the business of licensing or otherwise providing products or services competitive with the Software. 
“Designated Site” means your facilities or offices located at the postal address provided to Licensor for your billing and invoicing 
purposes, unless otherwise indicated in a license key provided to you. “Software” means the software product(s) accompanying this 
EULA and the content therein; including the associated user manuals, user documentation and application program interfaces, and 
License Numbers and Registration Key(s) provided, and any patches, updates, upgrades, improvements, enhancements, fixes and 
revised versions of any of the foregoing that may be provided to you from time to time, and any combination of the foregoing. “License 
Number” means the code provided to you by Licensor to enable you to obtain a Registration Key. “Registration Key” means the key 
provided by Licensor with which you activate your copy of the Software. “Order” means that part of a written or electronic document  
that identifies (1) the Software to be licensed to you, (2) the Authorized Scope (defined below), (3) any Support purchases, (4) the 
purchase price, and (5) location for delivery, and in each case as expressly agreed upon by Licensor. “Affiliate” means any entity 
Controlling, Controlled by, or under common Control with the referenced entity, where the term “Control” means the possession, direct 
or indirect, of the power to direct or cause the direction of the management and policies of an entity, whether through the ownership of 

voting securities, by contract, or otherwise.  
1. YOUR PAYMENT O BLIGATIONS. You agree to pay all amounts due or incurred by you, including any late payment fees, as are specified 

in this EULA, in the Order, and/or any associated invoice. All fees and amounts due Licensor are exclusive of all taxes, duties shipping 

fees, and similar amounts. If any authority imposes a duty, tax or similar amount (other than taxes based on Licensor’s income), you 

agree to pay, or to promptly reimburse Licensor for, all such amounts. Unless otherwise indicated, all invoices are payable thirty (30) 

days from the date of invoice. Overdue amounts are subject to a late payment charge, at the lower rate of (i) one and one-half percent 

(1.5%) per month, or (ii) the maximum rate under applicable law. You agree to promptly pay or reimburse Licensor for all costs and 

expenses, including all reasonable attorneys’ fees, related to breach of your obligations under this EULA and/or Licensor’s enforcement 

of this EULA. All shipments by Licensor or its designee are FCA point of shipment (Incoterms 2000).  
2. ACCEPTANCE. Except with respect to Software provided under a Trial or Demonstration License (each defined below), you will be 

deemed to have accepted the Software unless you provide written notice of rejection within ten (10) days after receipt of the Software or 

the corresponding License Number and Registration Key, if any (whichever event occurs first). Any such notice must state the reason 

for rejection, and you may only reject the Software if it fails to materially comply with its accompanying documentation. If you reject the 

Software, Licensor’s sole obligation and liability, and your sole and exclusive remedy, shall be for Licensor to use commercially 

reasonable efforts to deliver to you a replacement for the nonconforming Software, and if Licensor is not able to deliver a replacement 

for the Software, then Licensor will refund any license fees paid by you for the Software, and in the event of any such refund, the EULA 

shall terminate. Software provided under a Trial or Demonstration license shall be deemed accepted upon receipt.  
3. GRANT OF SOFTWARE LICENSE. Subject to the terms and conditions of this EULA, Licensor grants to you a non-exclusive, non-
transferable license (“License”) for Authorized Users to use the Software and Support for your internal operations and internal data 
processing purposes within and up to the Authorized Scope described on the Order, and for which you have paid the applicable license 
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and support fees and have registered the Software for use. Except as otherwise provided below, this EULA and the License granted 

hereunder shall be effective until terminated in accordance with Section 8 below. The term “Authorized Scope” means the following, 

and any other capacity, term/duration, or use restrictions indicated by Licensor on the license granted to you:  
If you have purchased a “Static License”, then, for each such license purchased you may install and operate the Softwareon a 

single designated computer (“workstation”) located at the Designated Site. You may not network the Software for use at any other geographic 

location. Use of the Software is limited to the single workstation designated for each Static License purchased.  
The Dynamic License configuration is comprised of a defined number of concurrent use licenses (Dynamic Licenses) 

sharedamong a defined number of workstations (“User Access Seats”). If you have purchased a “Dynamic License”, you may install the  
Software on the number of individual workstations located at the Designated Site for which you have purchased Seat Licenses; these 

Seats then share the number of Dynamic Licenses purchased. For example, if you purchased five (5) Dynamic Licenses and ten (10) 

Seat Licenses, you may enable the Software for concurrent use on up to five (5) of the ten (10) individual Seats simultaneously. You 

may not enable concurrent operation of the Software beyond the scope of the Dynamic and Seat Licenses purchased. You may not 

network the Software for use at any other geographic location. You must purchase and maintain an annual Software Maintenance and 

Support Policy for the duration of the License Term. Except as provided in Section 22, termination or expiration of support shall 

immediately terminate the Dynamic and Seat Licenses and this EULA.  
The Network License configuration is comprised of a defined number of concurrent use licenses (Network Licenses) sharedamong 

an UNLIMITED number of workstations (“User Access Seats”). If you have purchased a “Network License”, you may install  
the Software on all individual workstations located at the Designated Site for which you have purchased a Network License 

configuration; these Seats then share the number of Network Licenses purchased. For example, if you purchased eight (8) Network 

Licenses, you may enable the Software for concurrent use on up to eight (8) individual workstations simultaneously. You may not 

enable concurrent operation of the Software beyond the scope of the Network Licenses purchased. You may not network the Software 

for use at any other geographic location. You must purchase and maintain an annual Software Maintenance and Support Policy for the 

duration of the License Term. Except as provided in Section 22, termination or expiration of support shall immediately terminate the 

Network Licenses and this EULA.  
If you have purchased a “Site License”, then you may install and operate the Software on an UNLIMITED number ofindividual 

workstations located at the Designated Site. You may not network the Software for use at any other geographic location. You must purchase 

and maintain an annual Software Maintenance and Support Policy for the duration of the License Term. Except as provided in Section 22, 

termination or expiration of support shall immediately terminate the Site License and this EULA.  
If you have purchased a “Corporate License”, then you may install and operate the Software on an UNLIMITED number 

ofindividual workstations located at the Designated Site. A Corporate License allows you to use a single License Number to license all 

workstations. Furthermore, a Corporate License does not require each individual workstation to access Licensor’s License Registration Server 

through the Internet. Corporate License Numbers are Licensor’s Confidential Information. You may not network the Software for use at any 

other geographic location. You must purchase and maintain an annual Software Maintenance and Support Policy for the duration of the 

License Term. Except as provided in Section 22, termination or expiration of support shall immediately terminate the Corporate License and 

this EULA.  
If you have purchased a “Workgroup License”, then, for each such license purchased you may install and operate theSoftware 

on a single workstation located at the Designated Site. A Workgroup License enables you to create an unlimited number of Shared Databases; 

different types of Workgroup Licenses allow different numbers of users to access those Shared Databases. You may not network the Software 

for use at any other geographic location. Use of the Software is limited to the single workstation designated for each Workgroup License 

purchased. You must purchase and maintain an annual Software Maintenance and Support Policy for the duration of the License Term. Except 

as provided in Section 22, termination or expiration of support shall immediately terminate the Workgroup License and this EULA. 
 

If you have purchased a “Named User License”, then your license applies to the LabShareTM
Software only. You may allowup 

to the number of named users for which you have purchased a Named User License to connect to the LabShareTM Software. A “Named User” 

is defined as one individual user identified with a unique user name and password on the LabShareTM Software system. Each named user may 

operate no more than one LabShareTM session from a single individual workstation at a time. Only named users may use the LabShareTM 
Software. The individual workstations must all be located at the Designated Site. You may not network the Software for use at any other 
geographic location. You must purchase and maintain an annual Software Maintenance and Support Policy for the duration of the License 
Term. Except as provided in Section 22, termination or expiration of support shall immediately terminate the Named User Licenses and this 
EULA.  

Any Software provided under a “Trial License” is provided for your internal evaluation purposes only, pending your purchaseof a 

commercial-use Software license and payment of the applicable license fees. You may install and operate the Software on a single designated 

workstation located at the Designated Site. You may not network the Software for use at any other geographic location. A Trial License may not 

be used for any commercial purposes. A Trial License may automatically be converted into a commercial license (e.g., with Authorized Scope 

converted into a Static License) upon payment of the applicable license fees to Licensor or issuance of the applicable License Number and 

Registration Key, if any (whichever event occurs first). Upon such conversion, this EULA shall continue in full force and effect, subject to the 

restrictions applicable to the new Authorized Scope. Software provided under a Trial License is made available to you “AS IS”, AND 

LICENSOR MAKES NO REPRESENTATION OR WARRANTY REGARDING SUCH SOFTWARE.  
Any Software provided under a “Demonstration License” is provided for your internal demonstration purposes only, and notfor 

commercial or research purposes. You may not use the Software provided under a Demonstration License to operate upon data 
 
16 Vector NTI

®
 Express Installation and Licensing Guide 



other than the data provided to you under the Demonstration License. You may not use any other software in conjunction with the 

Software provided under a Demonstration License to operate upon data other than the data provided to you under the Demonstration 

License. Software provided under a Demonstration License is made available to you “AS IS”, AND LICENSOR MAKES NO 

REPRESENTATION OR WARRANTY REGARDING SUCH SOFTWARE.  
4. RESTRICTIONS ON USE. You acknowledge that you are receiving LICENSED RIGHTS only. The Software may only be used internally, 
by your Authorized Users, with the License Number and Registration Key (if any) provided, for your copy(ies) of the Software. If any 
Software is provided on separate media ( e.g., a CD-ROM), you may make a single copy solely for your internal backup purposes. You 
shall not directly or indirectly: (i) sell, rent, lease, distribute, redistribute or transfer any of the Software or any rights in any of the 
Software, including without limitation through “charge back” or any other selling, reselling, distributing or redistributing within your 
organization of any usage capacity you have licensed, without the prior express written approval of Licensor, (ii) modify, translate, 
reverse engineer (except to the limited extent permitted by law), decompile, disassemble, attempt to discover the source code for, 
create derivative works based on, or sublicense any of the Software, (iii) use any Software for the benefit of any third parties (e.g., in an 
ASP, outsourcing or service bureau relationship), or in any way other than in its intended manner, (iv) remove any proprietary notice, 
labels, or marks on or in the Software, or (v) disable or circumvent any access control or related device, process or procedure 
established with respect to the Software, including the License Number and Registration Key (if any) or any other part thereof. Further, 
without Licensor’s prior express written consent, you may not: (i) network the Software for use at any other geographic location; (ii) 
enable operation of concurrent “instances” of the Software beyond the scope of the license purchased; (iii) share accounts, e.g., pool 
multiple users through a single account, or (iv) “multiplex” or “pool” any Software, including through use of third party software products 
such as those made by Citrix Systems, Inc., or use any terminal applications/emulators to enable use of the software beyond the scope 
of the license purchased. If the Software design permits modification, then you may only use such modifications or new software 
programs for your internal purposes and otherwise consistent with the License and Authorized Scope. You are responsible for all use of 
the Software and for compliance with this EULA; any breach by you or any user of the Software shall be deemed to have been a breach 
by you. Licensor reserves all rights not expressly granted; no right or license is granted hereunder, express or implied or by way of 
estoppel, to any intellectual property rights other than as expressly set forth herein; and your purchase of a license to the Software does 
not by itself convey or imply the right to use the Software in combination with any other product(s). As between you and Licensor, 
Licensor retains all right, title, and interest in and to the Software, which rights include, but are not limited to, patent, copyright, moral, 
trademark, trade secret and all other intellectual property rights. You agree and acknowledge that you have been provided sufficient 
information such that you do not need to reverse engineer the Software in any way to permit other products or information to 
interoperate with the Software.  
5. NO SEPARATION OF COMPONENTS. The Software is licensed as a single product. Some Licensor software products combine separately 

available components into a single product (e.g., a software suite product may be comprised of multiple component products). When 

licensed as a combination product, the component parts may not be separated for use independently of the combination product. You 

must first purchase a license to each component of the combination product before you may use it independently of the combination 

product.  
6. TEACHING LICENSES. The Software may be licensed under a Teaching License program. Software licensed under such a program  
is subject to (i) the terms of a Static License as described in Section  3 and (ii) the additional restrictions in this Section 6. Software 

licensed under a “Teaching License” is restricted to use by students and teachers only in support of the classroom instruction of 

students and related class-work, such as the preparation of classroom materials, and the review and grading of exams, papers and 

class-related projects. Students may use the Software for class-related laboratory work and homework assignments. Use of the 

Software licensed under such a Teaching License program for any purposes other than as described in this Section, including for 

commercial or production purposes, or for non-classroom related research, is strictly prohibited.  
7. ADDITIONAL PURCHASES. Purchase of additional or changed licenses or Authorized Scope is subject to availability and current pricing. 

Licensor may, from time to time, update the available Authorized Scope plans, and add or delete from available plans. To the extent 

you purchase an upgrade to your license by expanding the Authorized Scope under a changed or additional plan, Licensor will provide 

you with the additional license terms and conditions governing your use of the Software under such plans; all other terms and 

conditions of this EULA shall remain in effect.  
8. TERM AND TERMINATION. Unless otherwise agreed, the term of this EULA shall continue until it is terminated; however, if you are 

receiving a Trial or Demonstration License, the term shall expire thirty (30) days following the date you receive the Software. 
Termination or expiration of this EULA shall concurrently terminate all Licenses granted under this EULA. Licensor shall not refund any 

amounts paid by you hereunder in the event of expiration or termination of this EULA unless expressly provided in this EULA. Licensor 

may (i) terminate an Order and the Licenses to the Software and/or Support on that Order if you fail to pay any applicable fees due 

under that Order within fifteen (15) days after receipt of written notice of non-payment; and/or (ii) terminate this EULA (or any License) 
upon fifteen (15) days written notice if you breach this EULA and do not cure the breach within fifteen (15) days following receipt of 

written notice of breach. Immediately upon any termination or expiration of this EULA, you agree to: (a) pay all amounts owed to 

Licensor; (b) un-install and cease use of the Software for which your rights have been terminated; (c) upon request, return to Licensor 
(or destroy) all copies of the Software and any other Confidential Information or proprietary materials in your possession for which your 

rights have been terminated; and (d) upon request, certify in writing your compliance with (b) and (c), above.  
9. CONFIDENTIALITY. You agree to protect Licensor’s Confidential Information with the same degree of care used to protect your own 

confidential information (but in no event less than a reasonable standard of care), and not to use or disclose any portion of such 

Confidential Information to third parties, except as expressly authorized in this EULA. You acknowledge that the Software, including its 

content, structure, organization and design constitute proprietary and valuable trade secrets (and other intellectual property rights) of 
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Licensor and/or its licensors. The term “Confidential Information” means, collectively, non-public information that Licensor (and its 

licensors) provide and reasonably consider to be of a confidential, proprietary or trade secret nature, including but not limited to (i) the 
Software, (ii) Software License and Support prices, (iii) Software License Numbers and Registration Keys, and (iv) confidential elements 
of the Software and Licensor’s (and its licensors’) technology and know-how, whether in tangible or intangible form, whether designated 

as confidential or not, and whether or not stored, compiled or memorialized physically, electronically, graphically, photographically, or in 
writing. Confidential Information does not include any information which you can demonstrate by credible evidence: (a) is, as of the time 
of its disclosure, or thereafter becomes part of the public domain through no fault of yours; (b) was rightfully known to you prior to the 
time of its disclosure, or to have been independently developed by you without use of Confidential Information; and/or (c) is 

subsequently learned from a third party not under a confidentiality obligation with respect to such Confidential Information. Confidential 
Information that is required to be disclosed by you pursuant to a duly authorized subpoena, court order, or government authority shall 
continue to be Confidential Information for all other purposes and you agree, prior to disclosing pursuant to a subpoena, court order, or 

government authority, to provide prompt written notice and assistance to Licensor prior to such disclosure, so that Licensor may seek a 
protective order or other appropriate remedy to protect against disclosure.  
10. WARRANTY AND D ISCLAIMER. Licensor warrants that (i) except with respect to Software provided under a Trial or Demonstration 
License (in respect of which no warranty is made, as described in Section 3), for a period of twenty (20) days from the date of 
acceptance of the Software as described in Section  2, the Software will, under normal use and as unmodified, substantially perform the 
functions described in its accompanying documentation; and (ii) Licensor will perform Support services during the Support term in a 
professional and workmanlike manner. No warranty is provided for uses beyond the Authorized Scope. THE FOREGOING EXPRESS 
WARRANTIES REPLACE AND ARE IN LIEU OF ALL OTHER WARRANTIES AND REPRESENTATIONS BY LICENSOR, WHETHER 
EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO ANY IMPLIED OR OTHER WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, NON-INFRINGEMENT OR NON-MISAPPROPRIATION OF 
INTELLECTUAL PROPERTY RIGHTS OF A THIRD PARTY, CUSTOM, TRADE, QUIET ENJOYMENT, ACCURACY OF 
INFORMATIONAL CONTENT, OR SYSTEM INTEGRATION. NO WARRANTY IS MADE THAT ANY SOFTWARE WILL OPERATE IN 
AN ERROR FREE, UNINTERRUPTED OR COMPLETELY SECURE MANNER, IN COMBINATION WITH THIRD PARTY HARDWARE 
OR SOFTWARE PRODUCTS, OR THAT ALL DEFECTS CAN BE CORRECTED. YOU ACKNOWLEDGE THAT LICENSOR HAS NO 
CONTROL OVER THE SPECIFIC CONDITIONS UNDER WHICH YOU USE THE SOFTWARE. ACCORDINGLY, EXCEPT FOR THE 
FOREGOING EXPRESS WARRANTY, LICENSOR CANNOT AND DOES NOT WARRANT THE PERFORMANCE OF THE 
SOFTWARE OR ANY PARTICULAR RESULTS THAT MAY BE OBTAINED BY THE USE OF THE SOFTWARE. THE SOFTWARE 
AND SUPPORT DO NOT REPLACE YOUR OBLIGATION TO EXERCISE YOUR INDEPENDENT JUDGMENT IN USING THE 
SOFTWARE. The warranties made by Licensor may be voided by abuse or misuse of the Software and/or Support.  
11. EXCLUSIVE REMEDY. Licensor’s sole obligation and liability, and your sole and exclusive remedy under the warranties set forth in 

Section  10, shall be for Licensor to use commercially reasonable efforts to have the problem remedied, to re-perform Support services, 

to deliver to you a replacement for the defective Software, or to refund fees paid (in each case, as determined by Licensor and as 

applicable), provided that Licensor is notified in writing of all warranty problems during the applicable warranty period.  
12. THIRD PARTY SOFTWARE AND DATABASES. This Software uses third-party software components from several sources. Portions of 
these software components are copyrighted and licensed by their respective owners. Various components may require distribution of 
source code or if a URL is used to point the end-user to a source-code repository, and the source code is not available at such site, the 
distributor must, for a time determined by the license, offer to provide the source code. In such cases, please contact your Life 
Technologies representative. In addition, various licenses require that the end user receive a copy of the license. Such licenses, if any, 
may be found in a folder called “Licenses” which is located in the root directory of the Software. You understand that third party 
products integrated into the Software or provided for use with the Software may be subject to additional terms and conditions and/or 
license agreements from the applicable third party vendor, which shall govern over conflicting terms of this EULA for purposes of your 
relationship with the third party vendor. You agree not to use any such third party product on a stand-alone basis independent of the 
Software, unless you have purchased the appropriate license from the third party vendor for use of such products. 
NOTWITHSTANDING ANYTHING TO THE CONTRARY IN THIS AGREEMENT, ALL THIRD PARTY SOFTWARE, DATABASES AND 
OTHER PROGRAMS AND SOFTWARE COMPONENTS ARE PROVIDED “AS IS” WITHOUT ANY WARRANTY WHATSOEVER 
FROM LICENSOR. ANY DATABASES OR OTHER INFORMATION PROVIDED BY LICENSOR ARE DESIGNED TO SUPPLEMENT 
OTHER SOURCES OF INFORMATION, ARE NOT INTENDED TO REPLACE YOUR PROFESSIONAL DISCRETION AND 
JUDGMENT AND LICENSOR MAKES NO REPRESENTATIONS OR WARRANTIES REGARDING SUCH DATABASES OR 
INFORMATION, THEIR ACCURACY, COMPLETENESS OR OTHERWISE. Licensor agrees, upon request and as Licensor’s sole 
liability and obligation, and for your convenience only, to have passed through to you (to the extent it may reasonably do so) any 
warranties and indemnifications provided by the applicable third party vendor of any third party products provided to you. To the extent 
any problem or liability arises from a third party product, you agree to seek recourse solely from the applicable third party vendor and 
not Licensor.  
13. LICENSOR INDEMNIFICATION. Subject to the limitations set forth herein, Licensor agrees to defend you against any claims, actions, 

suits and proceedings brought against you by unaffiliated third parties arising from or related to a claim that the Software (other than 

any third party or open source components or elements) infringes upon such third party’s copyrights, and Licensor agrees to pay all 

damages that a court finally awards to such third party, and all associated settlement amounts agreed to by Licensor in writing; provided 

that, Licensor receives from you (i) prompt written notice of the claim; (ii) all necessary assistance, information and authority necessary 

for Licensor to defend the claim and perform Licensor’s obligations under this Section; and (iii) sole control of the defense of such claim 

and all associated settlement negotiations. If such a claim is made or appears likely to be made, you agree to permit Licensor to enable 
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you to continue to use the affected Software, or to have the Software modified to make it non-infringing, or to have the Software 

replaced with a substantially functional equivalent. If Licensor determines that none of these options is reasonably available, then 
Licensor may terminate this EULA in whole or with respect to the affected Software product, and you may be entitled to a credit equal to 

the price paid for the affected product, less depreciation assuming a three (3) year useful life and straight-line depreciation. THIS 

SECTION STATES LICENSOR’S AND ITS AFFILIATES’ ENTIRE OBLIGATION AND LIABILITY REGARDING INFRINGEMENT OF 
THIRD PARTY RIGHTS OF ANY KIND OR CLAIMS OF ANY SUCH INFRINGEMENT. Licensor will have no responsibility for (v) any 

use of any product after you have been notified to discontinue use because of a third party claim of infringement, (w) the alteration of 

the Software or the combination of the Software with third party materials, products or software, (x) use of the Software by any person 

or entity other than an Authorized User, (y) any misuse or unauthorized use of the Software, or (z) failure to use provided updated or 
modified Software to avoid a claim of infringement or misappropriation.  
14. INDEMNIFICATION BY YOU. You agree to indemnify and defend Licensor, its licensors, and its affiliates, against any third party claims 

arising from or related to your use or misuse of the Software or any breach of the terms and conditions of this EULA, and you agree to 

pay all costs, losses, damages, and attorneys’ fees that a court finally awards, and all associated settlements.   
15. LIMITATION OF LIABILITY. EXCEPT TO THE EXTENT PROHIBITED BY APPLICABLE LAW, IN NO EVENT WILL LICENSOR’S OR 

ITS AFFILIATES’ TOTAL, AGGREGATE LIABILITY ARISING FROM OR RELATED TO THIS AGREEMENT, THE SOFTWARE 

AND/OR SUPPORT (INCLUDING FOR NEGLIGENCE, STRICT LIABILITY, BREACH OF CONTRACT, MISREPRESENTATION, AND 

OTHER CONTRACT OR TORT CLAIMS), EXCEED THE AMOUNT OF YOUR DIRECT DAMAGES ACTUALLY INCURRED, UP TO 

THE AMOUNT OF FEES PAID TO LICENSOR UNDER THIS AGREEMENT FOR THE SOFTWARE PRODUCT OR SUPPORT 

PRODUCT THAT IS THE SUBJECT OF THE CLAIM UNDERLYING THE DAMAGES; OR, IN THE CASE OF SOFTWARE PROVIDED 

UNDER A TRIAL OR DEMONSTRATION LICENSE, ONE HUNDRED DOLLARS ($100.00), WHICHEVER IS LESS.   
16. EXCLUSION OF DAMAGES. EXCEPT TO THE EXTENT PROHIBITED BY APPLICABLE LAW, UNDER NO CIRCUMSTANCES 
SHALL LICENSOR, ITS AFFILIATES, OR ANY OF THEIR SUPPLIERS OR LICENSORS BE LIABLE HEREUNDER FOR ANY OF  
THE FOLLOWING: (I) THIRD PARTY CLAIMS, EXCEPT AS PROVIDED IN SECTION  13, (II) LOSS OR DAMAGE TO ANY 

SYSTEMS, RECORDS OR DATA, (III) DIRECT DAMAGES FOR BREACH OF WARRANTY (IN RESPECT OF WHICH ANY LIABILITY 

SHALL BE LIMITED TO RE-PERFORMANCE OR REFUND AS SPECIFIED IN SECTION 11), AND/OR (IV) INDIRECT, INCIDENTAL, 

SPECIAL, CONSEQUENTIAL, PUNITIVE, RELIANCE, OR COVER DAMAGES (INCLUDING WITHOUT LIMITATION FOR LOST 

PROFITS, LOST SAVINGS AND DAMAGE TO ANY DATA OR SYSTEMS); EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 

DAMAGES AND EVEN IF A LIMITED REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL PURPOSE. YOU ARE SOLELY 

RESPONSIBLE AND LIABLE FOR VERIFYING THE ACCURACY AND ADEQUACY OF ANY OUTPUT FROM THE SOFTWARE, 

AND FOR ANY RELIANCE THEREON.  
THE FEES FOR THE SOFTWARE AND SUPPORT, THE REMEDIES SET FORTH IN THIS AGREEMENT, THE LIMITS ON 

LIABILITY SET FORTH IN SECTIONS  15 AND  16 AND THE OTHER PROVISIONS IN THIS AGREEMENT REFLECT THE 

ALLOCATION OF RISKS BETWEEN THE PARTIES. THIS SECTION IS AN ESSENTIAL ELEMENT OF THE BASIS OF THE 

BARGAIN BETWEEN THE PARTIES.  
17. VERIFICATION. Licensor shall have the right to have on-site audits periodically conducted of your use of the Software. These audits 

are for license verification purposes only, will generally be conducted during regular business hours, and Licensor will use its 

reasonable efforts not to interfere unduly with your regular business activities. Licensor may also require you to accurately complete a 

self-audit questionnaire in a form Licensor may have provided. If an audit reveals unauthorized use, you must promptly purchase 

sufficient licenses and Authorized Scope to permit all usage disclosed. If material unlicensed use is found (i.e., license shortage of 5% 

or more), you also shall reimburse Licensor for all costs incurred in connection with the verification, including without limitation 

reasonable attorneys’ fees.  
18. REGULATED USES. You acknowledge that the Software has not been cleared, approved, registered or otherwise qualified 

(collectively, "Approval") by Licensor with any regulatory agency for use in diagnostic or therapeutic procedures, or for any other use 

requiring compliance with any federal or state law regulating diagnostic or therapeutic products, blood products, medical devices or any 

similar product (hereafter collectively referred to as "federal or state drug laws"). The Software may not be used for any purpose that 

would require any such Approval unless proper Approval is obtained. You agree that if you elect to use the Software for a purpose that 

would subject you or the Software to the jurisdiction of any federal or state drug laws, you will be solely responsible for obtaining any 

required Approvals and otherwise ensuring that your use of the Software complies with such laws.  
19. EUROPEAN COMMUNITY END USERS. If this Software is used within a country of the European Community, nothing in this Agreement 
shall be construed as restricting any rights available under the European Community Software Directive, O.J. Eur. Comm. (No. L. 122)   
42 (1991).  
 
20. LEGAL COMPLIANCE; RESTRICTED RIGHTS. The Software is provided solely for internal research and solely for lawful purposes and 
use. You shall be solely responsible for, and agree to comply with, all applicable laws, statutes, ordinances, and other governmental 
authority, however designated. Without limiting the foregoing, this EULA is expressly made subject to any United States government 
laws, regulations, orders or other restrictions regarding export from the United States and re-export from other jurisdictions of 
equipment, computer hardware, software, technical data and information or derivatives of such equipment, hardware, software or 
technical data and information. You agree to comply with all applicable export and re-export control laws and regulations in regard to   
products (including computer hardware, software, deliverables, technical data, source code, or any other technology, equipment, and/or 

derivatives of such hardware, software, deliverables, technical data, source code, equipment, or any other technology) received from 

Licensor. You further certify that you will not, directly or indirectly, without obtaining prior authorization from the competent government 
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authorities as required by those laws and regulations: (1) sell, export, re-export, transfer, divert, or disclose technical data or dispose of 

any product or technology received from Licensor to any prohibited person, entity, or destination; or (2) use the product or technology 
for any use prohibited by the laws or regulations of the United States. You will reasonably cooperate with Licensor and will provide to 

Licensor promptly upon request any certificates or documents as are reasonably requested to obtain approvals, consents, licenses 

and/or permits required for any payment or any export or import of products or services under this EULA, at Licensor’s expense. Your 
breach of this provision shall constitute cause for immediate termination of this EULA. You agree to indemnify and hold harmless 

Licensor, its affiliates, and their respective officers, directors, employees and agents for your noncompliance with this Section. The 

Software is a "commercial item," as that term is defined in 48 C.F.R. 2.101, consisting of "commercial computer software" and 

"commercial computer software documentation," as such terms are used in 48 C.F.R. 12.212. Consistent with 48 C.F.R. 12.212 and 48 
C.F.R. 227.7202-1 through 227.7202-4, all U.S. Government End Users acquire the Software with only those rights set forth herein.  
21. G OVERNING LAW ; SEVERABILITY. This EULA shall be governed in all respects by the laws of the State of California, USA, without 

regard to its conflicts of law rules or principles. Any dispute arising out of or related to this EULA shall be resolved only in the state or 

federal courts having subject matter jurisdiction in California. This Agreement shall not be governed by the United Nations Convention 

on Contracts for the International Sale of Goods. Each party hereby consents to the exclusive jurisdiction and venue of such courts. If 

any provision of this EULA is held to be illegal or unenforceable for any reason, then such provision shall be deemed to be restated so 

as to be enforceable to the maximum extent permissible under law; the remainder of this EULA shall remain in full force and effect.  
22. SOFTWARE MAINTENANCE AND SUPPORT. Licensor offers certain software maintenance and technical support service programs 
documented in Licensor’s then-current Support policies (“Support”). Subscription to Support shall be governed by this EULA and by  
the terms and conditions set forth in such policies. Licensor shall have no obligation to provide Support if (a) the Software is not used in 

accordance with the accompanying documentation or Authorized Scope; (b) the Software was modified by you; (c) you have not 

implemented all upgrades that would otherwise correct the problem; or (d) the problem is caused by your misuse, negligence or other 

cause within your control. Licensor may change its Support policies and prices at any time. Licensor reserves the right to discontinue 

Support services for any Software where Licensor generally discontinues such services to all Licensees of such Software, in which case 

such discontinuation shall not automatically terminate this EULA and the License. If you terminate Support and then re-enroll, Licensor 

may charge you a reinstatement fee.  
23. GENERAL. This EULA, including any Orders, Support policies, and associated Licensor invoices (all of which are incorporated herein), are 

collectively the parties’ complete agreement regarding its subject matter, superseding any prior oral or written communications, representations 

or agreements. In the event that any prior oral or written communication is in direct conflict with the terms of this EULA, this EULA shall control. 

You understand and agree that, to the extent Licensor permits you to use a non-Licensor purchase order or other form to order Software and/or 

Support, Licensor does so solely for your convenience. Any terms in any such forms that purport to vary or are in addition to or inconsistent 

with any terms in this EULA or in the applicable Order shall be deemed to be void and of no effect. Amendments or changes to this EULA must 

be in mutually executed writings to be effective. Sections 1, 4, 5, and 8 through 23, inclusive, shall survive the termination or expiration of this 

EULA. The parties are independent contractors for all purposes under this EULA. Neither party shall be liable for any delay or failure due to 

force majeure and other causes beyond its reasonable control; provided that the foregoing shall not apply to any of your payment obligations. 

Any notices under this EULA to Licensor must be personally delivered or sent by certified or registered mail, return receipt requested, or by 

nationally recognized overnight express courier, to the address specified herein or such other address as Licensor may specify in writing. Such 

notices will be effective upon receipt, which may be shown by confirmation of delivery. All such notices shall be sent to the attention of the 

Chief Legal Officer of Life Technologies Corporation (unless otherwise specified by Licensor). You may not assign or otherwise transfer this 

EULA or any License without Licensor’s prior written consent. This EULA shall be binding upon and inure to the benefit of the parties’ 

successors and permitted assigns. You agree, at Licensor’s request and reasonable expense, to provide reasonable assistance and 

cooperation to Licensor and its designees, and to give testimony and execute documents and to take such further acts reasonably requested 

by the other to acquire, transfer, maintain, perfect, and enforce Licensor’s intellectual property rights as described in this EULA. To the extent 

you fail to do so, you appoint Licensor’s or its affiliates’ officers as your attorney in fact to execute documents on your (and your personnel's), 

successors’ and assigns’ behalf for this limited purpose. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

20 Vector NTI
®

 Express Installation and Licensing Guide 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Headquarters  
5791 Van Allen Way | Carlsbad, CA 92008 USA | Phone +1 760 603 7200 | Toll Free in USA 800 955 

6288 

For support visit  www.lifetechnologies.com/support 
 
 www.lifetechnologies.com 
07 March 2014 

http://www.lifetechnologies.com/support
http://www.lifetechnologies.com/

	Vector NTI® Express Installation and Licensing Guide
	Copyright
	Table of Contents
	System settings and requirements
	Download the software
	Install the software
	Launch the software
	License the software
	Software Updates
	Windows® operating systems: Multiple users on the same computer
	Transfer software to a new computer or operating system
	Appendix A. Technical support
	Appendix B. Reinstallation policy
	Appendix C. Vector NTI® Express Software and Support Product License Agreement
	Back Cover




